BAB 111
METODE PENELITIAN

3.1 Desain Penelitian

Metode penelitian yang digunakan dalam penelitian ini yaitu metode
eksperimen. Karena sifat dari penelitian ini adalah adanya sebuah perlakuan khusus
yang diberikan pada sampel. Penelitian eksperimen adalah salah satu metodologi
penelitian paling kuat yang dapat digunakan para peneliti. Karakteristik utama dari
penelitian eksperimen yang membedakannya dari semua jenis penelitian lainnya
adalah bahwa peneliti memanipulasi variabel independen. Mereka memutuskan
sifat perlakuan (yaitu apa yang akan terjadi pada subjek penelitian), kepada siapa
itu akan diterapkan, dan sejauh mana (Fraenkel et al., 2012). Peneliti menggunakan
desain Faktorial 2x2, yaitu seperti yang diungkapkan oleh Fraenkel dkk. bahwa
nilai lain dari desain faktorial adalah memungkinkan peneliti untuk mempelajari
interaksi variabel independen dengan satu atau lebih variabel (terkadang disebut
variabel moderasi). Variabel moderasi dapat berupa variabel perlakuan atau
variabel khusus subjek. Variabel-variabel dalam penelitian ini terdiri dari dua
variabel bebas, yaitu (1) model role-playing Shaftel (RPS), dan (2) model role-
playing Rivera (RPR). Selanjutnya terdapat juga variabel atribut yaitu kecerdasan
emosional yang terdiri dari (1) tingkat kecerdasan emosional tinggi, dan (2) tingkat
kecerdasan emosi rendah. Sedangkan variabel terikatnya adalah keterampilan sosial
siswa. Untuk lebih jelasnya mengenai desain penelitian faktorial 2x2 disajikan pada
Tabel 3.1.

Tabel 3. 1 Desain Penelitian Faktorial 2x2

Model Pembelajaran

Tingkat Kecerdasan Role-Playing Shaftel Role-Playing Rivera
Emosional (El) (RPS) (A1) (RPR) (A2)
Tinggi (Bl) A1B1 A2 B1
Rendah (B>) A1 B> A B>
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Keterangan:

Aq Role-laying Shaftels (RPS).

A Role-playing Rivera (RPR).

B1 Kelompok kecerdasan emosional tinggi.

B2 Kelompok kecerdasan emosional rendah.

A1B: Kelompok siswa yang belajar dengan menggunakan model
pembelajaran role-playing Shaftel (RPS) dan memiliki kecerdasan
Emosional tinggi.

A2B: Kelompok siswa yang belajar dengan menggunakan model
pembelajaran role-playing Rivera (RPR) dan memiliki kecerdasan
emosional tinggi.

A1 B> Kelompok siswa yang belajar dengan menggunakan model
pembelajaran role-playing Shaftel (RPS) dan memiliki kecerdasan
emosional rendah.

Az B> Kelompok siswa yang belajar dengan menggunakan model

pembelajaran role-playing Rivera (RPR) dan memiliki kecerdasan

emosional rendah.

3.2 Validitas Internal dan Eksternal

99

Berdasarkan desain penelitian yang ditentukan yakni Factorial Design,

penelitian ini perlu melakukan pengontrolan terhadap validitas internal dan

validitas eksternal. Hal ini bertujuan untuk mengeliminasi kelemahan-kelemahan

yang ada dalam desain tersebut. Pengontrolan penting untuk dilakukan agar

rancangan penelitian yang dilakukan dapat memenuhi persyaratan untuk pengujian

hipotesis, dan hasil dari perlakuan (treatment) yang diberikan dapat mencerminkan

perlakuan yang diberikan, serta dapat digeneralisasikan kepada populasi yang ada.

Berikut ini adalah dijelaskan lebih lanjut tentang pengontrolan yang dilakukan

terhadap validitas internal dan validitas eksternal.
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3.2.1 Validitas Internal

100

Freankel dkk (2012, him. 280) menjelaskan beberapa ancaman yang terjadi

pada penelitian dengan Factorial Design. Ancaman tersebut disajikan pada Tabel

3.2 berikut ini.
Tabel 3. 2 Analisis Ancaman Desain Penelitian
No. Threat Keefektifan
1 | Subject characteristics ++
2 Mortality ++
3 Location -
4 Instrumen Decay ++
5 Data Collector Characteristics -
6 Data Collector Bias -
7 | Testing +
8 History +
9 Maturation ++
10 | Attitude of Subjects -
11 | Regression ++
12 | Implementation -
Keterangan:
++ : Kontrol yang kuat, ancaman tidak mungkin terjadi
+ :  Kontrol, ancaman mungkin dapat terjadi

- : Lemahnya kontrol, ancaman mungkin terjadi

Dari Tabel 3.2 terlihat ada beberapa ancaman yang perlu dikontrol. Apabila

tidak dikontrol, ancaman tersebut akan melemahkan penelitian. Ancaman tersebut

antara lain, location, data collector characteristics, data collector bias, attitude of

subjects dan implementation. Adapun upaya yang dilakukan untuk mengontrol

berbagai ancaman tersebut sebagai berikut:

1. Lokasi penelitian (location)

Usaha yang dilakukan terkait dengan pengaruh lokasi penelitian yaitu

menggunakan beberapa alternatif lokasi, dimana saat terjadi kendala, seperti saat

hujan peneliti memindahkan lokasi penelitian di dalam ruangan yang memugkinkan

program pembelajaran tetap dilaksanakan tanpa hambatan.
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2. Karekteristik pengambilan data (data collector characteristics)

Usaha yang dilakukan agar tidak terjadi pengaruh karakterisitk
pengumpulan data penelitian menggunakan instrumen yang sama setiap melakukan
tes terhadap partisipan penelitian.

3. Bias Pengumpulan Data (data collector bias)

Merujuk pada subjek yang melakukan tes yang memungkinkan memiliki
penafsiran ganda mengenai aturan tes. Cara pengendaliannya antara lain pemberian
penjelasan mengenai langkah-langkah melakukan tes yang jelas, agar siswa
memahami dengan mudah dan tidak menimbulkan penafsiran ganda.

4. Perilaku subjek (attitude of subjects)

Merujuk pada sikap peneliti pada saat proses pembelajaran. Cara
pengendaliannya adalah dengan tidak memberikan penekanan yang dapat menjadi
beban psikologis pada siswa dan juga tidak membeda-bedakan siswa satu dengan
yang lain.

5. Implementasi (implementation)

Merujuk pada pemberian materi yang mungkin berbeda dalam melakukan
perlakukan. Salah satu strategi pengendalian untuk menjaga konsistensi materi
yang diajarkan adalah dengan memastikan bahwa guru yang terlibat dalam

penelitian tetap sama dari awal hingga akhir.

3.2.2 Validitas Eksternal
Pengontrolan validitas eksternal adalah pengendalian terhadap beberapa
faktor agar hasil penelitian dapat digeneralisasikan. Pengkontrolan tersebut
meliputi:
1. Validitas Populasi
Bertujuan agar karakteristik sampel dapat mewakili populasi. Pada
penelitian ini sampel yang digunakan seluruhnya merupakan anggota populasi
sehingga dapat digeneralisasikan pada sekolah yang peneliti pilih.
2. Validitas Ekologi
Dikontrol dengan menggunakan program pembelajaran disusun dan
dijadwalkan dengan jelas, tidak mengubah jadwal yang telah ditetapkan,

menggunakan sarana dan prasarana yang cukup memadai, tidak memberitahu
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kepada partisipan bahwa mereka sedang dijadikan subyek penelitian untuk

menghindari pengaruh reaktif akibat proses penelitian tersebut.

3.3 Partisipan

Partisipan adalah orang yang terlibat dalam penelitian dengan cara
memberikan dukungan (tenaga, pikiran maupun materi) dan tanggung jawabnya
terhadap setiap keputusan yang telah diambil demi tercapainya tujuan yang telah
ditentukan bersama. Partisipan dalam penelitian ini terdiri dari 60 siswa sekolah
dasar kelas VI di Kecamatan Bayongbong Kabupaten Garut dengan rentang usia
11-12 tahun dan jenis kelamin laki-laki dan perempuan. Partisipan dalam penelitian
ini yaitu peneliti sendiri yang memiliki pengalaman mengajar selama satu tahun di
Sekolah Dasar (SD) dan tiga tahun di Sekolah Menengah Pertama (SMP), serta
tujuh tahun mengajar pada program studi Pendidikan Jasmani, Kesehatan, dan
Rekreasi di STKIP Pasundan Cimahi. Selain untuk menunjang terlaksananya
penelitian, peneliti dibantu oleh 4 orang guru pendidikanan jasmani.

3.4 Populasi dan Sampel
3.4.1 Populasi

Populasi dan sampel merupakan bagian yang penting dari sebuah penelitian.
Ketelitian dalam menentukan sampel dari sejumlah populasi sangat menentukan
hasil penelitian yang dilakukan. Populasi merupakan individu atau objek yang
memiliki sifat-sifat umum. Dari populasi dapat diambil sejumlah data yang
diperlukan untuk memecahkan suatu masalah yang diteliti. Populasi adalah wilayah
generalisasi yang terdiri atas obyek/subyek yang mempunyai kualitas dan
karakteristik tertentu yang ditetapkan oleh peneliti untuk dipelajari dan kemudian
ditarik kesimpulannya. Penelitian ini melibatkan seluruh siswa kelas VI Sekolah
Dasar yang berada di Kecamatan Bayongbong, Kabupaten Garut. Jumlah
keseluruhan siswa yang terlibat dalam penelitian ini adalah 141 orang, dengan
rincian 54 orang dari SDN 1 Bayongbong, 34 orang dari SDN 2 Bayongbong, 37
orang dari SDN 3 Bayongbong, dan 16 orang dari SDN 6 Bayongbong.
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3.4.2 Sampel

Berdasarkan kepada kebutuhan penelitian yang akan menggunakan sampel
siswa yang memiliki kecerdasan emosional tinggi dan rendah, maka teknik untuk
menentukan sampel pada penelitian menggunakan teknik non probabilitas
sampling. Langkah yang diambil dari total populasi sebanyak 141 siswa diukur
tingkat kecerdasan emosionalnya untuk mengetahui siswa yang memiliki
kecerdasan emosional tinggi dan emosional rendah. Kemudian hasilnya disusun
mulai dari skor tingkat emosional tinggi sampai dengan siswa yang memiliki
tingkat emosional rendah dengan persentasi 27% batas atas yang mewakili nilai
tinggi dan 27% batas bawah yang mewakili nilai rendah (Verducci, 1980). Sehingga
didapat 30 siswa pada kelompok atas dan 30 siswa pada kelompok bawah.

Langkah selanjutnya, sampel terdiri dari 60 orang dibagi menjadi empat
subkelompok dengan 15 orang di setiap kelompok. Pembagian kelompok dilakukan
menggunakan metode random assignment. Keempat kelompok tersebut adalah, A1
B1  vyaitu kelompok siswa yang belajar dengan menggunakan model role-
playing Shaftel (RPS) dan memiliki kecerdasan emosional tinggi; A2 Bl yaitu
kelompok siswa yang belajar dengan menggunakan model role-playing Rivera
(RPR) dan memiliki kecerdasan emosional tinggi; Al B2 yaitu kelompok siswa
yang belajar dengan menggunakan model pembelajaran role-playing Shaftel (RPS)
dan memiliki kecerdasan emosional rendah; A2 B2 yaitu kelompok siswa yang
belajar dengan menggunakan model pembelajaran role-playing Rivera (RPR) dan
memiliki kecerdasan emosional rendah. Untuk lebih jelas dapat dilihat pada Tabel
3.3.

Tabel 3. 3 Jumlah Sampel Setiap Kelompok

Model Pembelajaran Role-Plying

Tingkat Shaftel (RPS) (A1) Rivera (RPR) (A2)
Kecerdasan Emosional Jumlah
Tinggi (B1) 15 15 30
Rendah (B2) 15 15 30
Total 60
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3.5 Definisi Operasional Variabel
Untuk memfokuskan penelitian ini sehingga tidak ada salah penafsiran dan
kesimpangsiuran dalam judul disertasi ini, maka peneliti membatasi/merumuskan

definisi operasional variabel- variabel yang diteliti.

3.5.1 Role-Playing

Model role-playing adalah suatu cara penguasaan bahan-bahan pelajaran
melalui pengembangan imajinasi dan penghayatan siswa. Pengembangan imajinasi
dan penghayatan dilakukan siswa dengan memerankannya sebagai tokoh hidup atau
benda mati. Permainan ini pada umumnya dilakukan lebih dari satu orang, hal itu
bergantung kepada apa yang diperankan. Model role-playing Shaftel (RPS) dan
role-playing Rivera (RPR) disini akan digunakan dalam pelajaran pendidikan
jasmani, dimana siswa akan bermain peran sesuai dengan materi pendidikan
jasmani seperti sepak bola, bola voli, bulu tangkis, dan tenis meja. Adapun contoh
skenario pembelajaran dapat dilihat pada Tabel 3.12 ataupun dalam Lampiran.
3.5.2 Kecerdasan Emosional

Kecerdasaan Emosional yang dimaksud dalam penelitian ini adalah
kemampuan individu untuk mengenali perasaan orang lain, perasaan sendiri,
mengelola emosi, keterampilan sosial, memanfaatkan emosi dan memotivasi diri
sendiri (Vaughan & Laborde, 2018).
3.5.3 Keterampilan sosial

Keterampilan sosial adalah keterampilan atau kemampuan individu dalam
berinteraksi secara verbal maupun nonverbal agar dapat beradaptasi dan diterima
oleh lingkungan. Adapun indikator keterampilan sosial dalam penelitian ini
mencakup beberapa aspek, diantaranya keterampilan interaksi (Gresham & Elliott,
1990), keterampilan komunikasi (Pratiwi et al., 2022; Takahashi et al., 2006),
keterampilan partisipasi, keterampilan sosial kognisi dan keterampilan emosional

(Jureviciené et al., 2018).

3.6 Instrumen penelitian
Instrumen merupakan elemen penting dalam sebuah penelitian karena

instrumen berfungsi sebagai alat pengumpulan data yang kemudian data tersebut di
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analisis sehingga dapat diperoleh kesimpulan dari sebuah penelitian. Dalam
penelitian ini penulis menggunakan dua instrumen, yaitu skala kecerdasan

emosional dan skala keterampilan sosial.

3.6.1 Instrumen Kecerdasan Emosional

Instrumen yang digunakan untuk mengukur kecerdasan emosional siswa
adalah skala kecerdasan emosional yang disusun sendiri, namun tetap mengacu
pada karya (Vaughan & Laborde, 2018). Langkah pertama dalam penyusunan skala
ini adalah menyusun kisi-kisi yang didasarkan pada konsep dan definisi operasional
tentang kecerdasan emosional. Selanjutnya, kerangka kerja tersebut
dikonsultasikan dengan Tim Promotor, yang juga berperan sebagai penilai ahli,
serta dengan pakar psikososial. Berikut ini disajikan konsep dan definisi
operasional tentang kecerdasan emosional yang dijadikan rujukan dalam menysun
kisi-kisi skala.

1) Definisi konseptual

Salovey dan Mayer dalam (Behera, 2016; Petrides, 2009) menjelaskan
bahwa kecerdasan emosional adalah kecerdasan dalam memahami perasaan diri
sendiri dan perasaan orang lain, dapat memotivasi dan mengelola emosi dalam
menjalani kehidupan.

2) Definisi operasional

Kecerdasan emosional yang dimaksud dalam penelitian ini mencakup
beberapa aspek, diantaranya menilai emosi orang lain, menilai emosi sendiri,
regulasi emosi, keterampilan sosial, pemanfaatan emosi dan optimisme (Vaughan
& Laborde, 2018).

Berdasarkan definisi di atas, dibuat beberapa indikator serta sub indikator
dalam kisi-kisi keterampilan sosial. Dari indikator dan sub indikator yang telah ada,
mulai disusun pernyataan yang sifatnya positif serta negatif. Setelah pernyataan
tersusun, dibuat undian untuk mengundi penomoran setiap pernyataan untuk disalin
ke dalam lembaran skala yang akan dibagikan pada sampel untuk diisi. Hasil uji
coba selanjutnya dihitung validitas dan reliabilitasnya. Item yang dinyatakan valid
dipertahankan, sedangkan item yang dinyatakan tidak valid tidak digunakan.

Berikut disajikan Kisi-kisi instrumen kecerdasan emosional pada Tabel 3.4.
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Tabel 3. 4 Kisi-Kisi Uji Coba Skala Kecerdasan Emosional

Variabel Indikator No Soal

+ -
Kecerdasan Menilai Emosi Orang Lain 104 11,12
Emosioanl Menilai Emosi Diri Sendiri 620 16,19
Mengelola Emosi 51 3,24
Keterampilan Sosial 148 21,22
Pemanfaatan Emosi 18,15 23,13
Optimisme 2,7 9,17

Skala penilaiannya menggunakan skala Likert. Adapun alternatif jawaban

yang digunakan adalah sebagai berikut.

Tabel 3. 5 Skala Alternatif Jawaban Skala Keterampilan sosial

No Alternatif Jawaban Skor Alternatif Jawaban
Positif Negatif

1  Sangat setuju (SS) 4 1

2  Setuju (S) 3 2

3  Tidak setuju (TS) 2 3

4 Sangat tidak setuju (STS) 1 4

3.6.2 Uji Coba Instrumen

Skala kecerdasan emosional yang telah disusun selanjutnya diuji cobakan
untuk mengukur validitas dan reliabilitas dari setiap item. Hal ini dilakukan untuk
mengetahui ketetapan dan ketepatan instrumen yang akan digunakan telah
memenuhi syarat sebagai instrumen yang baik dan dapat digunakan sebagai
pengumpul data. Sebelum uji coba dilakukan, peneliti menetapkan sekolah yang
akan dijadikan tempat uji coba instrumen. Uji coba harus dilakukan pada sampel
yang homogen dengan sampel penelitian dan bukan pada sampel yang
sesungguhnya.

Uji coba instrumen dilakukan pada siswa kelas VI di empat Sekolah Dasar
yang berada di Kecamatan Bayongbong, Kabupaten Garut. Jumlah sampel pada uji
coba ini adalah 120 responden dari empat sekolah dasar yang berada di Kecamatan
Bayongbong, yaitu SDN 1 Sukamanah, SDN 2 Sukamanah, SDN 3 Sukamanah,
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dan SDN 4 Sukamanah. Alasan memilih sekolah tersebut adalah karena memiliki
karakteristik yang hampir sama dengan tempat penelitian, baik dalam segi letak
geografis maupun karakteristik siswa. Sekolah yang dijadikan uji coba instrumen
memiliki letak geografis yang berdekatan dengan sekolah yang akan dijadikan
tempat penelitian. Siswa yang menjadi subjek uji coba instrumen memiliki

karakteristik yang sama, yaitu berusia 11-12 tahun dan duduk di kelas VI.

3.6.3 Pengujian Validitas dan Reliabilitas Instrumen

Setelah dilakukan uji coba instrumen kecerdasan emosional, langkah
selanjutnya yaitu menguji validitas dan reliabilitasnya. Instrumen uji coba
kecerdasan emosional terdiri dari 24 item. Pengujian validitas dan reliabilitas
dilakukan dengan menggunakan IBM SPSS 25. Untuk uji validitas yang digunakan
didalam instrumen kecerdasan emosional ini adalah uji validitas item tes untuk
menentukan seberapa valid suatu item pertanyaan dalam mengukur kecerdasan
emosional. Dari hasil yang diperoleh dengan menggunakan IBM SPSS 25 dengan
menggunakan teknik analisis Cronbach's alpha. Dari hasil analisis yang telah
dilakukan dari 24 item tes diperoleh sebanyak 24 dinyatakan valid. Untuk lebih
jelas dapat di lihat pada Tabel 3.6.

Tabel 3. 6 Hasil Uji Validitas Item Tes Kecerdasan Emosional

No Item Tes  r hitung r tabel Keterangan
1 0,294 0,179 Valid
2 0,385 0,179 Valid
3 0,353 0,179 Valid
4 0,292 0,179 Valid
5 0,308 0,179 Valid
6 0,209 0,179 Valid
7 0,471 0,179 Valid
8 0,250 0,179 Valid
9 0,456 0,179 Valid
10 0,283 0,179 Valid
11 0,181 0,179 Valid
12 0,288 0,179 Valid
13 0,294 0,179 Valid
14 0,335 0,179 Valid
15 0,432 0,179 Valid
16 0,411 0,179 Valid
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No Item Tes  r hitung r tabel Keterangan
17 0,560 0,179 Valid
18 0,339 0,179 Valid
19 0,278 0,179 Valid
20 0,302 0,179 Valid
21 0,521 0,179 Valid
22 0,331 0,179 Valid
23 0,450 0,179 Valid
24 0,305 0,179 Valid

Untuk menyatakan butir pernyataan tersebut valid atau tidak valid, penulis
menggunakan nilai r tabel product moment dengan signifikansi untuk o = 0,05 dan
dk = 120 - 2 = 118, maka diperoleh nilai-nilai r = 0,179. Kemudian r tabel
dibandingkan dengan r hitung, jika r hitung > r tabel maka butir pernyataan
dinyatakan valid, jika r hitung < r tabel maka butir pernyataan dinyatakan tidak
valid. Dari tabel 3.5 dapat diketahui bahwa terdapat 24 butir pernyataan yang
dinyatakan valid.

Langkah selanjutnya adalah mengetahui nilai reliabilitas instrumen penulis
menggunakan IBM SPSS 25 dengan menggunakan teknik analisis Cronbach's
alpha. Dari hasil analisis didapat nilai reliabilitas sebesar 0,68. Berdasarkan tabel
pedoman untuk memberikan interpretasi koefisien korelasi (Sugiyono, 2011, him.
275) nilai 0.68 masuk dalam kategori tinggi, yakni berada pada interval koefisien
0.60 — 0.79 dengan tingkah hubungan yang tergolong tinggi. Hal ini berarti
instrumen kecerdasan emosional memiliki reliabilitas tinggi. Adapun hasil uji

validitas setiap instrumen lengkap dapat dilihat pada Lampiran.

3.6.4 Instrumen Keterampilan Sosial

Instrumen yang digunakan untuk mengukur keterampilan sosial siswa
adalah skala keterampilan sosial yang disusun sendiri, namun tetap mengacu pada
karya (Gresham & Elliott, 1990; JureviCiené et al., 2018; Pratiwi et al., 2022;
Takahashi et al., 2006). Langkah pertama dalam penyusunan skala ini adalah
menyusun Kisi-kisi yang didasarkan pada konsep dan definisi operasional tentang
keterampilan sosial. Selanjutnya, kerangka kerja tersebut dikonsultasikan dengan
Tim Promotor, yang juga berperan sebagai penilai ahli, serta dengan pakar
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psikososial. Berikut ini disajikan konsep dan definisi operasional tentang
kecerdasan emosional yang dijadikan rujukan dalam menysun kisi-kisi skala.
1) Definisi konseptual

Keterampilan sosial adalah keterampilan yang seseorang gunakan untuk
berkomunikasi dan berinteraksi satu sama lain, baik secara verbal maupun non-
verbal, melalui gerak tubuh, bahasa tubuh dan penampilan pribadi (Rachmah,
2016).

2) Definisi operasional

Keterampilan sosial yang dimaksud dalam penelitian ini mencakup
beberapa aspek, diantaranya keterampilan interaksi (Gresham & Elliott, 1990),
keterampilan komunikasi (Pratiwi et al., 2022; Takahashi et al., 2006), keterampilan
partisipasi, keterampilan sosial kognisi dan keterampilan emosional (Jureviciené et
al., 2018).

Berdasarkan definisi di atas, dibuat beberapa indikator serta sub indikator
dalam kisi-kisi keterampilan sosial. Dari indikator dan sub indikator yang telah ada,
mulai disusun pernyataan yang sifatnya positif serta negatif. Setelah pernyataan
tersusun, dibuat undian untuk mengundi penomoran setiap pernyataan untuk disalin
kedalam lembaran skala yang akan dibagikan pada sampel untuk diisi. Hasil uji
coba selanjutnya dihitung validitas dan reliabilitasnya. Item yang dinyatakan valid
dipertahankan, sedangkan item yang dinyatakan tidak valid tidak digunakan.
Berikut disajikan kisi-kisi instrumen keterampilan sosial pada Tabel 3.7.

Tabel 3. 7 Kisi-Kisi Uji Coba Skala Keterampilan Sosial

Variabel Sub Variabel Indokator No Soal
+ -
Keterampilan ~ Keterampilan 1. Kemampuan manajemen 9 14
Sosial Interaksi dan mengontrol interaksi
dengan orang lain
Keterampilan 1. Kemampuan menyesuaikan 19 5
Komunikasi volume suara
2. Kemampuan 2 18

mengendalikan emosi

3. Kemampuan berkata positif 11 10
4. Kemampuan untuk 8 7
mendengarkan
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Variabel Sub Variabel Indokator No Soal
+ =
5. Kemampuan untuk 4 23
memperhatikan ketika orang
berbicara
Keterampilan 1. Kemampuan berpartisipasi 13 12
Partisipasi dalam aktivitas kelompok
Keterampilan 1. Kemampuan kepekaan 26 1
Emosional emosional
2. Kemampuan untuk 24 15

mengekspresikan emosi
3. Kemampuan kesadaran diri 25 22

4. Kemampuan untuk 20 16
mengendalikan diri
Keterampilan 1. Kemampuan untuk peka 6 17
Sosial Kognisi  terhadap lingkungan sosial
2. Kemampuan membuat 21 3
keputusan

Skala penilaiannya menggunakan skala Likert. Adapun alternatif jawaban

yang digunakan adalah sebagai berikut.

Tabel 3. 8 Skala Alternatif Jawaban Skala Keterampilan sosial

No Alternatif Jawaban Skor Alternatif Jawaban
Positif Negatif

1  Sangat setuju (SS) 4 1

2  Setuju (S) 3 2

3  Tidak setuju (TS) 2 3

4 Sangat tidak setuju (STS) 1 4

3.6.5 Uji Coba Instrumen

Skala yang telah disusun selanjutnya diuji cobakan untuk mengukur
validitas dan reliabilitas dari setiap item. Hal ini dilakukan untuk mengetahui
ketetapan dan ketepatan instrumen yang akan digunakan telah memenuhi syarat
sebagai instrumen yang baik dan dapat digunakan sebagai pengumpul data.
Sebelum uji coba dilakukan, peneliti menetapkan sekolah yang akan dijadikan
tempat uji coba instrumen. Uji coba harus dilakukan pada sampel yang homogen

dengan sampel penelitian dan bukan pada sampel yang sesungguhnya.
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Uji coba instrumen diberikan kepada siswa kelas VI di empat Sekolah Dasar
yang berada di Kec. Bayongbong Kab. Garut. Jumlah sampel pada uji coba ini
adalah 130 responden dari empat sekolah dasar yang berada di Kec. Bayongbong,
yaitu SDN 1 Sukamanah, SDN 2 Sukamanah, SDN 3 Sukamanah, dan SDN 4
Sukamanah. Alasan memilih sekolah tersebut karena memiliki karakteristik yang
hampir sama dengan tempat penelitian, baik dalam segi letak geografis maupun
karakteristik siswa. Sekolah yang dijadikan uji coba instrumen memiliki letak
geografis yang berdekatan dengan sekolah yang akan dijadikan tempat penelitian.
Siswa yang menjadi subjek uji coba instrumen memiliki karakteristik yang sama,
yaitu berusia 11-12 tahun dan duduk di kelas V1.

3.6.6 Pengujian Validitas dan Reliabilitas Instrumen

Setelah dilakukan uji coba instrumen keterampilan sosial, langkah
selanjutnya yaitu menguji validitas dan reliabilitasnya. Instrumen uji coba
keterampilan sosial terdiri dari 26 item. Pengujian validitas dan reliabilitas
dilakukan dengan menggunakan SPSS versi 25. Untuk uji validitas yang digunakan
didalam intrumen keterampilan sosial ini adalah uji validitas item tes untuk
menentukan seberapa valid suatu item pertanyaan mengukur keterampilan sosial.
Dari hasil yang diperoleh dengan menggunakan bantuan IBM SPSS versi 25.
dengan menggunakan teknik analisis Cronbach's alpha. Dari hasil analisis yang
telah dilakukan dari 26 item tes diperoleh sebanyak 24 dinyatakan valid. Untuk
lebih jelas dapat dilihat pada Tabel 3.9 di bawah ini.

Tabel 3. 9 Hasil Uji Validitas Item Tes Keterampilan Sosial

No Item Tes r hitung r tabel Keterangan
1 0.296 0.172 Valid
2 0.299 0.172 Valid
3 0.107 0.172 Tidak Valid
4 0.128 0.172 Tidak Valid
5 0.416 0.172 Valid
6 0.439 0.172 Valid
7 0.451 0.172 Valid
8 0.241 0.172 Valid
9 0.291 0.172 Valid
10 0.549 0.172 Valid
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No Item Tes r hitung r tabel Keterangan
11 0.483 0.172 Valid
12 0.380 0.172 Valid
13 0.327 0.172 Valid
14 0.220 0.172 Valid
15 0.417 0.172 Valid
16 0.457 0.172 Valid
17 0.496 0.172 Valid
18 0.340 0.172 Valid
19 0.344 0.172 Valid
20 0.431 0.172 Valid
21 0.414 0.172 Valid
22 0.238 0.172 Valid
23 0.459 0.172 Valid
24 0.308 0.172 Valid
25 0.330 0.172 Valid
26 0.285 0.172 Valid

Untuk menyatakan butir pernyataan tersebut valid atau tidak valid, penulis
menggunakan nilai r tabel product moment dengan signifikansi untuk o= 0,05 dan
dk = 130 - 2 = 128, maka diperoleh nilai-nilai r = 0,172. Kemudian r tabel
dibandingkan dengan r hitung, jika r hitung > r tabel maka butir pernyataan
dinyatakan valid, jika r hitung < r tabel maka butir pernyataan dinyatakan tidak
valid. Dari tabel 3.5 dapat diketahui bahwa terdapat 24 butir pernyataan yang
dinyatakan valid dan dua butir pernyataan yang dinyatakan tidak valid yakni butir
tiga dan empat.

Langkah selanjutnya adalah mengetahui nilai reliabilitas instrumen penulis
menggunakan IBM SPSS versi 25 dengan menggunakan teknik analisis Cronbach's
alpha. Dari hasil analisis didapat nilai reliabilitas sebesar 0,71. Berdasarkan tabel
pedoman untuk memberikan interpretasi koefisien korelasi (Sugiyono, 2009, p.
275) nilai 0,71 masuk dalam kategori tinggi yakni berada pada interval koefisien
0.600 — 0.799 dengan tingkat hubungan yang tergolong tinggi. Hal ini berarti
instrumen kecerdasan emosional memiliki reliabilitas tinggi. Adapun tabel
pedoman untuk memberikan interpretasi koefisien korelasi dapat dilihat pada Tabel
3.10.
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Tabel 3. 10 Pedoman Interpretasi Koefesien Korelasi

Interval Koefisien Tingkat Hubungan
0.800 — 1.000 Sangat Tingi
0.600 —0.799 Tinggi
0.400 - 0.599 Sedang
0.200 - 0.399 Rendah
0.000 - 0.199 Sangat rendah

3.7 Teknik Pengumpulan Data
Data untuk kecerdasan emosional dan keterampilan sosial diperoleh dari
skala pada kedua kelompok baik eksperimen maupun kontrol. Adapun teknik
pengumpulan datanya sebagai berikut:
1. Lembaran skala diberikan pada sampel pada saat pembelajaran penjas.
2. Pengisian skala dikerjakan selama 40 menit.
3. Lembaran skala yang berisi jawaban dikumpulkan.
4. Peneliti melakukan pemeriksaan dan memberi skor atas hasil tes yang
dikerjakan.
5. Skor yang dihasilkan merupakan data penelitian tentang minat siswa dalam

mengikuti penjas.

3.8 Prosedur penelitian
3.8.1 Langkah-Langkah Penelitian

Berikut adalah langkah-langkah dan alur penelitian yang dilakukan dalam
penelitian ini. Langkah pertama, yaitu melaksanakan tes kecerdasan emosional
untuk membagi siswa yang memiliki kecerdasan emosional tinggi dan kecerdasan
emosional rendah; Langkah kedua, melaksanakan pre-test keterampilan sosial, hal
tersebut untuk melihat sejauh mana kemampuan keterampilan sosial yang dimiliki
sampel pada kedua kelompok. Selain itu, untuk mendapatkan data keterampilan
sosial siswa, data didapatkan melalui skala keterampilan sosial; Langkah ketiga
menerapkan sebuah treatment, perlakuan diberikan kepada kedua kelompok yaitu
kelompok RPS dan kelompok RPR. Kedua kelompok mendapat perlakuan yang
berbeda namun dengan materi yang sama. Perbedaan perlakuan terletak pada cara
mengajarkan materi dalam pembelajaran pendidikan jasmani. Kelompok
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eksperimen diajarkan menggunakan RPS sedangkan kelompok kontrol diajarkan
menggunakan RPR. Penelitian dilaksanakan selama 12 kali pertemuan yang
mengacu kepada penelitian (O. Gilay et al., 2010; Sohrabi, 2022), jumlah waktu
belajar per pertemuan adalah 2x35 menit (Gil-madrona et al., 2019), dilaksanakan
dua kali dalam satu minggu mengacu kepada penelitan (Bofill-herrero et al., 2022;
Sniras, 2022) , yang mana penelitian tersebut dengan 12 kali pertemuan dan dua
kali dalam seminggu memberikan pengaruh terhadap peningkatan keterampilan
sosial; Langkah keempat, yaitu melaksanakan post-test. Pada kegiatan post-test ini,
siswa kembali melaksanakan tes keterampilan sosial. Tes akhir ini dilakukan
bertujuan untuk melihat dan mengetahui sejauh mana peningkatan yang terjadi pada
siswa setelah diberikannya sebuah treatment berupa pembelajaran pendidikan

jasmani dengan menggunakan role-playing Shaftels (RPS) dan role-playing Rivera

(RPR).

3.8.2 Jadwal Pembelajaran

Tabel 3.11 berikut ini menyajikan jadwal pembelajaran dari kedua
perlakuan yang akan dilakukan disertai waktu pelaksanaan pemberian perlakuan.

Tabel 3. 11 Jadwal Pembelajaran

PERTEMUAN KELOMPOK

MATERI

PERLAKUAN

1 A1B1 Permainan Sepak Bola Model pembelajaran RPS
A1B> Permainan Sepak Bola Model pembelajaran RPS
AzB1 Permainan Sepak Bola Model Pembelajaran RPR
ArB> Permainan Sepak Bola Model Pembelajaran RPR
Ai1B1 Permainan Sepak Bola Model pembelajaran RPS
2 AiB: Permainan Sepak Bola Model pembelajaran RPS
AzB1 Permainan Sepak Bola Model Pembelajaran RPR
AzB> Permainan Sepak Bola Model Pembelajaran RPR
AB: Permainan Sepak Bola Model pembelajaran RPS
3 Ai1B2 Permainan Sepak Bola Model pembelajaran RPS
AzB1 Permainan Sepak Bola Model Pembelajaran RPR
A2B: Permainan Sepak Bola Model Pembelajaran RPR
A1B; Permainan Bola VVoli  Model pembelajaran RPS
4 A1B: Permainan Bola Voli  Model pembelajaran RPS
AzB1 Permainan Bola VVoli  Model Pembelajaran RPR
A:B2 Permainan Bola VVoli  Model Pembelajaran RPR
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PERTEMUAN KELOMPOK MATERI PERLAKUAN
AiB1 Permainan Bola VVoli ~ Model pembelajaran RPS
AiB: Permainan Bola VVoli  Model pembelajaran RPS
5 AzB: Permainan Bola Voli ~ Model Pembelajaran RPR
A2B) Permainan Bola VVoli ~ Model Pembelajaran RPR
A1B: Permainan Bola Voli  Model pembelajaran RPS
A1B2 Permainan Bola VVoli  Model pembelajaran RPS
6 AzB1 Permainan Bola VVoli  Model Pembelajaran RPR
A:B2 Permainan Bola VVoli  Model Pembelajaran RPR
AiB: Permainan Bulutangkis Model pembelajaran RPS
AiB: Permainan Bulutangkis Model pembelajaran RPS
/ A:B1 Permainan Bulutangkis Model Pembelajaran RPR
A2B2 Permainan Bulutangkis Model Pembelajaran RPR
A1B1 Permainan Bulutangkis Model pembelajaran RPS
A1B> Permainan Bulutangkis Model pembelajaran RPS
8 A>B1 Permainan Bulutangkis Model Pembelajaran RPR
A2B2 Permainan Bulutangkis Model Pembelajaran RPR
A1B:1 Permainan Bulutangkis Model pembelajaran RPS
9 Ai1B: Permainan Bulutangkis Model pembelajaran RPS
AzB1 Permainan Bulutangkis Model Pembelajaran RPR
A2B: Permainan Bulutangkis Model Pembelajaran RPR
AiB1 Permainan Bulutangkis Model pembelajaran RPS
10 AB> Permainan Tenis Meja Model pembelajaran RPS
A:B1 Permainan Tenis Meja Model Pembelajaran RPR
A:B: Permainan Tenis Meja Model Pembelajaran RPR
A1B: Permainan Tenis Meja Model pembelajaran RPS
11 AiB: Permainan Tenis Meja Model pembelajaran RPS
AzB1 Permainan Tenis Meja Model Pembelajaran RPR
AzB> Permainan Tenis Meja Model Pembelajaran RPR
AiB: Permainan Tenis Meja Model pembelajaran RPS
12 AiB> Permainan Tenis Meja Model pembelajaran RPS
AsB1 Permainan Tenis Meja Model Pembelajaran RPR
AzB> Permainan Tenis Meja Model Pembelajaran RPR
Keterangan:
A1B: Kelompok siswa yang belajar dengan menggunakan model

pembelajaran role-playing Shaftel (RPS) dan memiliki kecerdasan

emosional tinggi.
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A:1B> : Kelompok siswa yang belajar dengan menggunakan model
pembelajaran role-playing Shaftel (RPS) dan memiliki kecerdasan
emosional rendah.

A2B: : Kelompok siswa yang belajar dengan menggunakan model
pembelajaran role-playing Rivera (RPR) dan memiliki kecerdasan
emosional tinggi.

A>B> : Kelompok siswa yang belajar dengan menggunakan model
pembelajaran role-playing Rivera (RPR) dan memiliki kecerdasan
emosional rendah.

Dalam setiap pertemuan pada kelompok RPS maupun kelompok RPR,
skenario pembelajaran dituangkan kedalam RPP yang sebelumnya telah dirancang.
Skenario pembelajaran terbagi menjadi tiga kegiatan yakni kegiatan pendahuluan,
kegiatan inti dan kegiatan penutupan. Secara garis besar dalam kegiatan
pendahuluan dan penutupan pada kelompok RPS dan pada kelompok RPR berisi
kegiatan yang sama. Perbedaan kelompok RPS dan kelopok RPR terletak pada
kegiatan inti pembelajaran. Untuk lebih lengkap tentang skenario pembelajaran dapat
dilihat pada Tabel 3.12 dan lampiran. Berikut salah satu contoh skenario pembelajaran

yang digunakan pada RPS dan RPR:

Tabel 3. 12 Skenario Pembelajaran RPS

Materi Pembelajaran . Tenis Meja
Kelas . VISD
Tujuan : 1) Siswa memiliki keterampilan dasar permainan

tenis meja: 2) siswa memiliki pengetahuan
permainan tenis meja; 3) siswa memiliki
keterampilan sosial yaitu keterampilan komunikasi.

Waktu 2 X35 menit

Media . Video tentang permainan tenis meja, dan cerita
permasalahan sosial dalam permainan tenis meja.

Alat dan Bahan : 1) Bet tenis meja; 2) Bola tenis meja; 3) Lapangan
tenis meja; 4) Net/jaring tenis meja; 5) Peluit dan
Stopwatch.

Budiman, 2024

PENGARUH MODEL PEMBELAJARAN ROLE-PLAYING DAN KECERDASAN EMOSIONAL TERHADAP
KETERAMPILAN SOSIAL DALAM PENDIDIKAN JASMANI

Universitas Pendidikan Indonesia | repository.upi.edu | perpustakaan.upi.edu



117

Kegiatan Deskripsi Kegiatan Waktu
Pembelajaran
A. Pendahuluan
Berdoa Berdoa 15 menit
Melaksanakan presensi ~ Presensi
Pemberian awareness Guru mengingatkan tentang tanggung
jawab dan menghormati tugas yang
didapat siswa dalam setiap perannya
Penyampaian tujuan Menjelaskan peraturan, prosedur dan
pembelajaran capaian dalam pembelajaran tenis meja
Pemanasan Peregangan statis dan dinamis
B. Kegiatan Inti
Fase 1: Dalam akhir pertandingan tenis meja 45 menit

Warm Up the Group

pemain tidak terima kekalahan (misal
tidak mau memberikan selamat kepada
pemenang dan tidak mau bersalaman)

Fase 2: Siswa terbagai dua kelompok untuk
Pilih peserta memainkan tenis meja.
Fase 3: Tom dan Jerry melakukan pertandingan

Atur Panggung

tenis meja sampai terdapat pemenang
dan yang kalah

Fase 4: Siapkan

Guru menetapkan tugas pengamat:

Pengamat 1. Mengidentifikasi alur cerita dalam
bermain peran
2. Mengidentifikasi karakter yang
diperankan siswa.

Fase 5: Tom: ya, Aku menang.

Enact/ Mulai Bermain
peran

Jerry: penampilan yang biasa aja, dan itu
kemenangan yang kebetulan!
Tom: Terserah!

Fase 6:
Diskusi dan Evaluasi
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1.Cintya berpendapat dengan cara “lihat
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“berbicaralah dengan suara yang jelas
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tersenyumlah dan ucapkan “permainan
yang menyenangkan”

4. Fariza dengan cara “berjabat tangan/
high five”
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Kegiatan Deskripsi Kegiatan Waktu
Pembelajaran
Fase 7: Guru menginstruksikan siswa untuk
Aktifkan Kembali bermain peran kembali dengan peran

yang diubah atau alternatif terbaru.
Tom: ya, Aku menang
Jerry: selamat Tom, kamu hebat hari ini.
Tom: terima kasih! permainan yang
bagus juga

Fase 8: Mengulang fase enam

Diskusi dan Evaluasi

Fase 9: e Siswa bercerita ketika memainkan

Berbagi Pengalaman peran sebagai pemain yang kalah.

dan Genaralisasi e Siswa bercerita perasaan ketika
memberi selamat kepada pemenang.

e Guru bertanya bagaimana cara
memberi selamat kepada pemenang.

e Guru bertanya mengapa pentingnya
mengendalikan emosi dan berkata
postif (seperti memberikan selamat
kepada pemenang).

e Guru meminta siswa untuk mengaitkan
social skill di pembelajaran pendidikan
jasmani dengan kehidupan sosial
lainnya.

e Guru meminta siswa untuk
menunjukkan perilaku mengendalikan
emosi dan berkata positif ketika situasi
di sekolah, di rumah dan di lingkungan
masyarakat.

C. Penutup
Pendinginan Peregangan statis 10 menit
Berdoa Berdoa

Total Waktu 70 menit

Sedangkan skenario untuk model pembelajaran RPR adalah sebagai berikut:
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Tabel 3. 13 Skenario Pembelajaran RPR

Materi Pembelajaran
Kelas
Tujuan

Waktu
Media
Alat dan Bahan

Tenis Meja

VI SD

1) Siswa memiliki keterampilan dasar permainan
tenis meja: 2) siswa memiliki pengetahuan
permainan tenis meja; 3) siswa memiliki
keterampilan sosial yaitu keterampilan komunikasi.
2 X 35 menit

Video tentang permainan tenis meja.

1) Bet tenis meja; 2) Bola tenis meja; 3) Lapangan
tenis meja; 4) Net/jaring tenis meja; 5) Peluit dan
Stopwatch.

Kegiatan Deskripsi Kegiatan Waktu
Pembelajaran
A. Pendahuluan
Berdoa Berdoa 15 menit
Melaksanakan presensi  Presensi
Pemberian awareness Guru mengingatkan tentang tanggung
jawab dan menghormati tugas yang
didapat siswa dalam setiap perannya
Penyampaian tujuan Menjelaskan peraturan, prosedur dan
pembelajaran capaian dalam pembelajaran tenis meja
Pemanasan Peregangan statis dan dinamis
B. Kegiatan Inti
1. Memilih salah satu Memberikan selamat kepada pemenang. 45 menit

keterampilan sosial

Bermain peran: Giant dan Marvel
memainkan peran bermain tenis meja.
Giant telah memenangkan pertandingan.

2. Modeling

Guru mengajarkan cara-cara positif
untuk memberi selamat kepada
pemenang:

a. Lihatlah orang yang anda puiji

b. Berbicaralah dengan suara yang jelas
dan antusias

c. Tersenyumlah dan ucapkan
“permainan yang menyenangkan”

d. Berjabat tangan atau high five

3. Bermain Peran
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Siswa bermain tenis meja sampai ada
yang menang dan kalah

Appropriate/ sesuai:

Tom: ya, Aku menang

Jerry: selamat Tom, kamu hebat hari ini.
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Kegiatan
Pembelajaran

Deskripsi Kegiatan

Waktu

Tom: terima kasih! permainan yang
bagus juga

Inappropriate/ tidak patut:

Tom: ya, Aku menang.

Jerry: penampilan yang biasa aja, dan itu
kemenangan yang kebetulan!

Tom: Terserah!

4. Menilai: tanya
jawab

Guru bertanya bagaimana cara
memberi selamat kepada pemenang.
Guru bertanya mengapa pentingnya
mengendalikan emosi, dan berkata
postif (seperti memberikan selamat
kepada pemenang).

Guru meminta siswa untuk mengaitkan
social skill di pembelajaran pendidikan
jasmani dengan kehidupan sosial
lainnya.

5. Follow Up

Guru meminta siswa untuk

menunjukkan perilaku mengendalikan
emosi, dan berkata positif ketika situasi
di sekolah, di rumah, dan di lingkungan
masyarakat

C. Penutup

Pendinginan

Peregangan statis

Berdoa

Berdoa

10 menit

Total Waktu

70 menit

3.9 Analis Data

Berikut teknik yang digunakan dalam penganalisisan data:

1) Uji Deskripsi Data:

Untuk menghitung mean, media, modus, simpangan baku, nilai minimum

dan nilai maksimum dengan menggunakan aplikasi IBM Statistical Package for the

Social Sciences (SPSS) Statistics 25. Tahapan penghitungan yang akan dilakukan

dengan langkah-langkah sebagai berikut: klik Analyze > Descriptive Statistics >

Descriptives > Masukkan semua variabel ke kotak Variable(s) > Options > ceklis

Mean, Std. Deviation, dan variance > Continue > OK.

2) Uji Prasyarat dengan:
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a) Uji Normalitas: untuk menguji kenormalan data diuji menggunakan uji
Kolmogorov Smirnov dengan bantuan SPSS 25. Tahapan penghitungan
yang dilakukan dengan langkah-langkah sebagai berikut: klik Analyze >
Nonparametric Test > Legacy Dialogs > 1- Sampel K-S > Masukan vaiabel
data A1, A2, By, B2, A1B1, A1B2, A2B1, A2B> ke kolom Tes Variabel List >
OK.
b) Uji Homogenitas: setelah uji normalitas, syarat yang diperlukan dalam
menggunakan ANOVA adalah uji homogenitas. Adapun tujuan uji
homogenitas adalah untuk mengetahui apakah varian populasi bersifat
homogen atau tidak. Pengujian homogenitas pada data kelompok sampel
dilakukan dengan uji Levane dengan bantuan SPSS 25. Tahapan
penghitungan yang akan dilakukan dengan langkah-langkah sebagai
berikut: klik Analyze > General Linear Model > Univariate > Variabel Y
masukan ke kotak dialog Dependent Variable, sedangkan Variabel X
(model pembelajaran dan kecerdasan emosional) masukkan ke kotak dialog
Fixed Factor > EM means > masukkan data semua yang ada dikotak Factor
(s) and Factor Intractions ke kotak Display Means for > Continue >
Options, ceklis Homogenity test > Continue > OK.
3) Uji Hipotesis:

Dalam menguji hipotesis penelitan ini menggunakan Analisis dua jalan
(Two Way Analysis of Varians) atau disingkat (ANOVA) dua jalur dengan bantuan
SPSS 25. Analisis ini dapat digunakan untuk menguji hipotesis yang menyatakan
perbedaan rata-rata antara kelompok-kelompok sampel baik yang menggunakan
Two Factorial Design atau Treatment by Level Design baik dalam penelitian
causal-comparative maupun penelitian eksperimen. Tahapan penghitungan yang
dilakukan dengan langkah-langkah sebagai berikut: Buka Tab Variable View: Buat
3 variabel dengan ketentuan sebagai berikut: 1) Variabel independen: 1. "Model"
dengan kategori Hybrid SE-IGCM dan SEM. Measure = Nominal, Decimals = 0,
Type = Numeric, dan isi Values: 1 = Tim, 2 = Individu; 2) Variabel independen:
2. "Kecerdasan Emosional" dengan kategori tinggi dan rendah. Measure =

Nominal, Decimals = 0, Type = Numeric, dan isi Values: 1 = Tinggi, 2 = Rendah;
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3) Variabel dependen: "keterampilan sosial". Measure = Scale, Decimals = 0, Type
= Numeric.

Kemudian, apabila adanya interaksi antara model pembelajaran Role-
playing dan kecerdasan emosional terhadap keterampilan sosial maka dilakukan uji
lanjut dengan menggunakan uji Tukey. Uji tersebut digunakan untuk menentukan
model mana yang lebih baik terhadap keterampilan sosial. Adapun langkah-
langkahnya sebagai berikut: klik Analyze > General Linear Model > Multivariate
> Masukan data keterampilan sosial ke ke kotak Dependent Variable, masukan
model pembelajaran dan kecerdasan emosional ke kotak Fixed factor(s) > klik Plot
masukkan model ke kotak Horizontal Axis dan kecerdasan emosional ke kotak
Separate Lines > add > continue >klik Post Hoc, masukkan model dan kecerdasan
emosional ke kotak Post Hoc Test for > Tukey > continue > klik Options >
Desriptive statistics > Estimates of effect size > Homogeneity tests > continue >
klik OK.
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